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I.   INTRODUCTION

2 Books about Publishing a Family History worth consulting: 

1.  John Townesend, Publishing Your Family History 
(Ottawa:British Isles Family History Society of Greater Ottawa, 
2003).  24 pp.  covers the whole process.  $5  from BIFHSGO.
See also his final article, “Publishing a Family History” in Anglo-
Celtic Roots, Vol 13, #2, Fall 2007  (same publisher).

2. Susan Yates and Greg Ioannou, Publish Your Family History,  
preserving your family’s heritage in a book (Toronto: The Ontario 
Genealogical Society, 2005)  154 pp.   mostly about book design 
and printing, by two authors in the printing business. 
$25 from OGS.   Printing details are out of date.  
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Before you start:

As John Townesend wrote, 

“I had to ask myself if I had enough interest, energy, time and 

money to see the project through”. 
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I planned to produce three documents over time:
  
In Oct 2006 I allowed six months for writing a Family History, to 
be followed by a Family Supplement.  
My move to Mississauga caused a one-year delay in the book.  
Actual time to write and print was 3 yr, 5 months!  

This is the only version of this family history that I plan to 
write, so time was taken to collect extra data & photos.  

I will produce a Family Supplement giving details of living people 
(my generation & younger) – to be distributed only in paper form 
& only within my immediate family group.  

I will distribute errata & updates later on to all holders of the book
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Selected Basic Requirements:

• Know, and state, who your intended audience is. 
Close Fraser – How descendants  

   Other Fraser – How descendants & genealogists 
“Posterity” for future family members & genealogists

copies to public libraries & OGS branches.  
• Choose a numbering system for Journal Reports: 

I use a custom version of the Record Format.
• Make sure all pronouns references are unambiguous!  
• Cite sources as much as possible for the main lines.
• Deal with issues of  © , privacy, and sensitivity.  
• Have your manuscript read by someone else. 
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 II.   CONTENTS OF MY BOOK

Hardbound with laminated cover
“Durabinding” allows pages to open flat

168 pages,  8.5 x 11”  
60 copies produced

Book has 30 pages of colour images
Five chapters deal with five different family groups
Each chapter has 

• an indented descendant chart 
• A descendant Journal report.  
• Black-and-white head and shoulder images are included where 

available.  
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In the book there are: 
• about 350 people named
• detailed accounts (1 or more pages long) for 27 people
• shorter accounts  (1 or 2 paragraphs long) for another 65 

people
• only brief listings for the remaining 260 people 

Structure

A good outline of chapters and sections, developed early, has 

preserved my sanity – I can prepare & revise sections as new 

information and photographs become available, and when I have 

time to work on it.  
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Title – should include names, places and dates.  

Inside title: 
The Families of J. Beverley Fraser

 and Elizabeth W. How 
 of Toronto, Canada

including their ancestors, descendants and relations 
from 1810 to 2010

Front cover omits the smaller text, “including . . .  

Book spine reads:  
The Fraser – How Family of Toronto         Douglas A. Hill
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Contents
 

(1) 1. Introduction

2. The Family of J. Beverley Fraser and Elizabeth W. How

(3) 3. The Family of Philip Fraser and Mary Gray

4. The Family of William Burgess and Elizabeth Watt

5. The How and Deans Families

6. The  Tooze Family 

(2) 7. Historical Trends and the Fraser – How Family

8. End Material and Name Index 
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III.   BOOK CHAPTER ONE: INTRODUCTION

 

Chapter One
Introduction
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1.1 Overview  (includes Key Persons Chart)

The Key Persons Chart uses colour-coded boxes to show who is 
included in each chapter

Chart produced using TMG’s Visual Chartform.

Chart printing problem:
can’t import the VCF chart format into Word
JPG out of VCF was poor
Printed VCF on best paper, scan with good resolution into JPG
Import JPG into Word document
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1.2    Outline of Book

1.3   Families Found in this Book
All of the approximately 350 people included in this book are found 

in the index at the back of the book.  The following four families are 
discussed to a significant extent in this family history.   

BURGESS Descendants of William Burgess (Sr), born 1809 in 
Edinburgh, Scotland, and Elizabeth Ann Watt, born 1816 in 
Ireland.  

FRASER Frasers (and one Frazer), mostly the descendants of George 
James Fraser, born 1841 in Ireland, and Jane Burgess, born 
1841 in Woodstock, Ontario.  They had eleven children.   
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HOW & Descendants of Thomas How (Jr), born 1820 in Middlesex,
DEANS England, and Elizabeth Deans, born 1821 in Bath, Somerset, 

England.

TOOZE Mostly descendants of Mark Tooze (Sr), born 1825 in 
Holcombe Rogus, Devon, England and Elizabeth Webber, 
born 1825 in the same town.    

In addition to the above families, the following seven families are listed 
or discussed to a lesser extent in this family history.  At least seven 
members of each family are known.    

HEWITT Descendants of Foster Hewitt, born 1902 in Toronto, and 
Elizabeth Kathleen How, born 1903 in Toronto.  Foster 
Hewitt was the famous hockey broadcaster for the Toronto 
Maple Leafs.  
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HILL Descendants of Elizabeth Jane Fraser, born 1915 in Toledo, 
Ohio, and Wilson William Hill, born 1913 in Toronto, 
Ontario.  The author is included here.

MACIVER Descendants of Rosena Millicent Fraser, born 1923 in 
Toronto, and Ray Donald MacIver, born 1921 in Toronto. 

PERKINS Descendants of Thomas E. Perkins, born 1848 in Quebec, 
and Harriet How, born 1854 in England.  Thomas was also 
the professional family photographer for the Hows.  

SHILTON Descendants of Isabell Fraser (a granddaughter of George J. 
Fraser) and John “Jack” Tyler Shilton.  

TAYLOR Descendants of John Norton Taylor, born 1927 in Adelaide, 
Australia, and Catherine Elizabeth Fraser, born 1939 in 
Toronto.
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1.4  Points of Interest
comments about famous people in the book 

1.5  Notes to the Reader
I do not expect a typical reader to “plow” their way through the 

whole book.  Genealogy charts listing lots of people can be pretty boring, 
even to a family historian.  Rather, a typical reader is encouraged to look 
through the image sections and read perhaps five to ten of the life stories 
presented in the most detail.  The two old letters from the Deans family, 
transcribed in sections 5.4 and 5.5, are also worth a look.  The details and 
listings for certain of the remaining people might also be of interest to 
particular readers. 
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IV.  BOOK CHAPTER SEVEN

This is “social history” seen through the eyes of my family.

Chapter Seven
Historical Trends and the 

Fraser – How Family
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7.2    Occupations and Annual Incomes

Occupations and Annual Incomes in the Fraser – How Family
Name Occupation Annual Earnings

1900 1910
              FRASER
George James Fraser deputy  collector,  Inland 

Revenue (1890 – 1913)
$1000 $1000

William P. Robinson traveller (i.e. salesman) $800
Philip Fraser (Sr) shoemaker $500 $850
                 HOW
Edward John How  (father) printer at The Globe $750 $988
Arthur Sydney How (son) jeweller at a “factory” $400 $720
Alfred Deans How   (son) tailor $300 not given
                TOOZE
William Oliver Taylor medical doctor $2000 not given
              OTHERS
various, not family members domestic servants and 

farm workers, getting free 
room and board

$120 to 
$200
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The effect of inflation from 1900 to 2007 is a factor of 25.65, 

so $1000 in 1900 inflates to $25,650 in 2007.     

Caution:  the “basket of goods & services” used for the inflation 
calculation keeps changing over time.  
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V.   WRITING A FAMILY STORY (IN GENERAL)  

CONTENT/PRESENTATION NOTES 
(derived from various sources) 

- Where put stories of parent & child?  With the parent.

- provide variety in font size and face

- make some use of quotations &/or extracts from old documents

- retype old letters verbatim in a script font (Example follows).

- text files on individuals should follow the chronological life order:  

grew up, education, marriage/family, residences, 

career/occupations, death/wills. 

- include personal stories where interesting.
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- use good photos of people; use slightly poor photos if best available

- include only the occasional interesting tombstone photos.

- scan both sides of a letter or postcard

- make it interesting  i.e.  a “good read” !

- be selective: don't include all the material you have

- list unresolved questions where you wish to

- be truthful re illegitimacy, family skeltons, etc. without inflicting 

pain on living people  

- clearly distinguish inferred relationships from proved ones

- make a separate author's biography 
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Notes from “Writing Family History” by Janet Lunn (Ottawa) 

 Add side topics in boxes.

Details bring the past to life. 

Test the text by reading it aloud. 

Break up the text with boxes, images, maps, etc.  

Recount the old time stuff:  before TV, old cars, outdoor plumbing, 

clothes, entertainment.  

Add paras on  things “now” vs “when I was a kid”.

Rewrite (at least a week after the original writing).  

Maps help readers unfamiliar with where things are. 

Local archives may want old family letters, documents, or manuscripts.
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Bay of Islands,   New Zealand. 
March 17th  1835      

My dear Father,
   I feel great pleasure in finding an 

opportunity whilst I am in this port of writing a letter to
you, perhaps it might  appear strange in my not
having written before but having met with no home-
ward bound vessels I could not possibly have done so.  
   We arrived here on the 10th of this month being exactly
4 Months from the Mother Bank, and 13 days more
from the port of London.  Captn Wright will leave New
Zealand as soon as possible, as he cannot get what he
wants near as cheap as he could wish.
   The next place we go to is Tongataboo, where we
shall get our Yams for the season on the line as it is
very fast approaching.  We have seen whales, and have
now got about 200 barrels, which is better than coming in
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here with nothing, and I dare say you would rather hear
we have it than nothing. I cannot describe to you the man-
manner [sic] in which the whales are caught you will hear. 
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VI.    SAMPLE CHAPTER WITH TMG JOURNAL REPORT

THIS CHAPTER PRESENTS THE DESCENDANTS of Philip Frazer and Mary 
Gray, the paternal grandparents of John Beverley Fraser.  
. . . . 

Chapter Three
The Family of Philip Fraser 

and Mary Gray
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3.1   List of Descendants of Philip Frazer and Mary Gray

This is a TMG Indented Descendant chart listing known descendants 
of Philip Frazer and Mary Gray.   120 people over 6 generations.
Philip1 Frazer, b. circa 1815 in Ireland
+Mary1 Gray [Fraser], b. circa 1815 in Ireland
└── George James2 Fraser, b. 6 Jul 1841 in County Sligo, Ireland, d.1919 in Toronto
    +Jane2 Burgess, b. 4 Dec 1841 in Woodstock, Upper Canada, d. 1920 in Toronto
    ├── Philip3 Fraser (Sr), b. 7 Aug 1863 in Woodstock, Canada West, d. 1925
    │   +Catherine Jane3 Johnston, b. 23 Feb 1862, d. 4 Nov 1903
    │   ├── Isabel Edith4 Fraser, b. 4 Apr 1888, d. 16 Dec 1965
    │   │   +John Tyler4 Shilton, b. 1884, d. 1950
    │   │   ├── James Fraser5 Shilton, b. 7 Apr 1915, d. 10 Dec 1983
    │   │   │   +Jean5 Baynton 
    │   │   │   ├── Kathleen6 Shilton 
    │   │   │   ├── Elizabeth6 Shilton 
    │   │   │   ├── Paul6 Shilton 
    │   │   │   ├── Caroline6 Shilton, b. 17 Oct 1954
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3.2   The Story of the Fraser – Gray Family

This journal report is limited to 4 generations, since generations 5 & 6 
are mostly living people.   It contains 85 people consisting of 55 
numbered descendants and 30 un-numbered spouses.   The numbering of 
these people starts with #5, since numbers 1 through 4 are used in the 
previous chapter and we are making the numbering continuous.  The 
section contains ten black-and-white head-and-shoulder images of 
people.
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3.3   Possible Siblings of George James Fraser

These two pages present evidence that three other people are likely 

siblings of George James Fraser, or possibly cousins.  

Richard Lundeen of Toronto kindly provided this evidence.   

Richard found one of my queries (through OGSPI); 

Richard also linked me to David Fraser in Atlanta Georgia.    

3.4   Images for the Fraser – Gray Family  
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Important journal report options & why:
General Tab: First reference number = 5 (the journal person #)

(chapter 2 used person numbers 1 through 4)
Sources Tab: endnotes unique

Use endnotes, since footnotes waste space & you cannot turn 
off the ibid feature; use unique to avoid duplicate references
Memos Tab: memos are embedded with parentheses (to make them 
appear where I want them)
Exhibits Tab: embed primary image (a head & shoulders portrait),  
but no captions (not needed)
Indexes Tab: [people] only
Tags Tab: all types (will include biography); Primary events (to  
exclude alternate versions)
Names Tab:  Child names: Honour name font styles 

(this gives child names in bold, matching the parents)
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Miscellaneous Tab:  BMDB in separate para at start; the only 
other event is the Biography tag, which contains the life story. 
- suppress details for living people (for privacy)
 

VII.   FIXING JOURNAL REPORTS IN WORD 
1. fix margins & save as  Word 2003 document.

Photos in Journal reports are added by Edit > Links > select, select 
all photos in the list > check “save picture in document” >  “Update 
now”.  

Then resize each photo.  
Right click > Format Picture > size tab: lock aspect ratio, set width to 2” 
>Layout tab:  wrapping = square;  horizontal alignment = other

> Advanced: Picture position > horizontal = 0.0” to right of column. 
& vert. position = absolute  0”  below para.  
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move object with text,  allow overlap
Text wrap:  square, wrap text on largest side only.

Distance: set all 4 sides to 0.2”  
The anchor only shows when you click on the image.  The picture moves 
to the next page with its anchor paragraph.  
Place all images to the left of the text.  

Note 1.  To be able to see and print images, which are “drawing 
objects”, set 
Tools > Options > Print > Include with document, check Drawing 
objects.   
Tools > Options > View > Show,  uncheck  Picture Placeholders.  

Note 2.   Journal reports put into MS Word cannot accumulate endnotes 
across multiple reports.  Thus, sources and memos listed as endnotes will 
appear at the end of each individual Word document (i.e. section of the 
book), with the numbering re-starting at number 1 each time.  
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Name index  The toolbar icon to Show/Hide the ¶ markings also 
reveals the hidden markings used to index names. 
 

The Name index is added by Word as follows: 
Insert > Reference > Index and Tables > Index > .. indented, 2 col, right 
align page numbers, select tab leader = dots,  Formats “from template”, 
Modify to change format if desired, & OK. 

The Name index is a field which can be updated as often as needed at 
any time.   In  any report, tell the reader what is indexed & what is not: 
names in Visual Chartform charts and in “life story paragraphs” (i.e. 
biography tags) are not indexed.  
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VIII. Printing

Administrative details (done in this order)

1.   Get ISBN  - free at LAC web site “ISBN Agency”
ISBNs are now 13 digits, previously 10 digits
my own “publisher prefix” is           0-9864999
  my first book’s ISBN is          978-0-9864999-0-6 

you can update the ISBN info after publication. 
e.g. revise month & year of actual publication, final weight.

there is a different ISBN for each binding of the book. 
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ISBN primer: (Wikipedia) 10 digit to end 2006; 13 digit after.
Most book stores only handle books with ISBN & bar code. 

  978 for the book industry   
                   my publisher code
978- 0 – 9864999 – 0 – 6   checksum number
                                 consecutive #s for titles       
   0 or 1 for  “English speaking countries”

The eight digits underlined cover the publisher code and the title 
code for his published books in a variable fashion:
Low-volume publishers have a 7-digit publisher’s code and only 1 
digit for the books since they will publish less than 10 books.

High-volume publishers have a shorter publisher’s code with more 
digits available to list all their books. 
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2.  Get CIP  (Cataloging in Publication) data 

Meet Four requirements to get CIP done:
• Book to be published in Canada
• Not yet published (time to add CIP data)
• Available for sale to the public
• Printing at least 100 copies

 

Send TOC and introduction chapter & name/address/etc  for the 
draft book electronically to LAC.  

Free from LAC (10 working days)  
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Insert CIP data on © page when get it.  

Library and Archives Canada Cataloguing in Publication

Hill, D. A. (Douglas Arthur), 1943-
The families of J. Beverley Fraser and Elizabeth W. How of Toronto, 

Canada : including their ancestors, descendants and relations from 1810 to 
2010 / Douglas Arthur Hill.

Includes bibliographical references and index.
ISBN 978-0-9864999-0-6

1. Fraser family.  2. How family.  3. Burgess family.  4. Tooze family.  
5. Deans family.  6. Toronto (Ont.)--Genealogy.  I. Title.

CS89.H56 2010                            929'.20971                          C2010-900240-7 
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3.  Maybe get Canadian Copyright – costs $50 ?

my proof of ©  claim is the records of my independent printer. 

4. Bar code for back cover – Not needed

- only need if book to be sold in bookstores 

- not free

40



Printing &   Binding    

• Printed by   Global Print Service,   a division of 
GlobalGenealogy.com  Inc.     (Rick Roberts)

• Word version converted to pdf using Acrobat Professional
• binding margin set in Word  (0.3”  is  too much)
• Pages are   8.5 x 11” with 1/8” trim
• 80 pound high opacity printers paper (acid free) to stop images 

showing through & give “weight”
• 60 copies in Durabind format, 2 unbound copies

this binding allows open pages to lay flat
• subsequent print runs of 25 at a time can be done  
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• “digital printing”   colour pages can be inserted anywhere 
(collation by hand)  don’t need groups of 8 like offset
Don`t need to group colour pages together to save money.

• printing cost was $35 + GST per book.  

Other
• I designed a separate cover; Rick Roberts printed the covers, 

and his binder bound them. 
• most printers want a pdf  file, or will convert to pdf.
• pdf colour may need adjustment (CYMK vs RGB)
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Distribution
• by hand or mailing.  
• Staples has a good ‘book mailer” box,    $1.75 each
• email some libraries first to confirm they would like a copy
• mailing in Canada averages $9 a book 
• 2 legal deposit copies to LAC
• LDS in Salt Lake City: 

 
OGS head office:  new electronic loan system

Sales?? 
1 copy sold to Coutts Information Services, Niagara Falls.   

http://www.couttsinfo.com   supplier to small libraries.
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What I would do differently  NEXT TIME

1. increase line spacing to 1.15 or 1.20 for ease of reading
2. allow less than 0.3”  for the binding margin
3. recheck final MS for accidental font size changes  

(example: top of  p. 8)
4. include one or more maps
5. Find a better way to get a VCF chart into Word
6. include an author’s photo

I await more comments on the book.  

I fear the book will be much praised and little read!
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